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Plan

e Session 1
 Workflow overview
e Basic data manipulation

e Session 2
e Join data tables
* JMP graphing

e Session 3

* Modelling
* JMP Journal
* JMP Scripting Language



Modeling in JMP

Linear regression (done)
* predict a continuous variable

Logistic regression: predict categorical variable

» supervised classification learning
* e.g., binomial logistic regression: the categorical variable has binary outcomes (e.g., 0, 1)

K-mean clustering: a method to partition observations (into clusters)
e unsupervised classification learning

Model selection
* Validation Column and Model Comparison

Outliers, missing values, and patterns

Note: the purpose of modelling isn’t just prediction.



Binomial Logistic Regression

* let Y be the binary outcome variable
* e.8.{0,1} = {fail, success}

* Letp = prob(Y = 1); 1%9 is then the odds of being 1 (or success)

* Binary logistic regression models the logit-transformed probability as a
linear relationship with the predictor variables

e maximum likelihood estimation

. p
logit(p) = log (E) = o+ [1 X1+ -+ Brxg.

https://stats.idre.ucla.edu/other/mult-pkg/fag/general/fag-how-do-i-interpret-odds-ratios-in-logistic-regression/



https://stats.idre.ucla.edu/other/mult-pkg/faq/general/faq-how-do-i-interpret-odds-ratios-in-logistic-regression/

Binomial Logistic Regression (Demo): Data

* Preference for a brand | oeergent- e
Of d ete rge nt (Ries a n d :Filt.e. E:iit _I‘Tables Ro»ivs “Cols : IZ-)OE _Analyze frap? Tools View Window Help
. = Sl LDA. OHEHEEFL»
Smlthl 1963) | Detergent D] 4 e
i Help > Sa m ple Data hogfjsd ;!ees ;:;\dprson%irtahm(glgg;scii - brand | softness previous use ttlzmperature count
Li b ra ry P> Nominal Logistic Regression ; X SO: yes lhlgh 152
X so yes ow
° Dete rge ntJmp 3 x soft no high 29
4 x soft no low 63
; Eolugms (5/0) 5 m soft yes high 29
ran
. i softness 3 6 'm soft yes IcTw 49
* Survey Questions i preious use Tmo ot no igh 27
ik temperature 3 8 m soft no low 53
1. which brand do you A count 9x  med yes high 23
10 x med yes low 47
preferl X Or m 11 % med no hi

gh 33
12 x med no low 66
2. water softness ) e ow e
3. previous user of m —— 4m  med yes ow 55
All rows 24 15 m med no high 23
4. water temperature Al rows ; 6m  med o jow 50
Excluded 0 17 | x hard yes high 24
Hidden 0 18 x hard yes low 37
Labelled 0 19 |x hard no high 42

evaluations done

=




Binomial Logistic Regression (Demo): Fit

* Analyze > Fit Model

= Fit Model - JMP Pro

4 =/ Model Specification

~Select Columns

¥ !5 Columns

th brand

th softness

Wk previous use
[ 8 temperature
A count

~ Pick Role Variables

| Personality:

I

‘ brand

optional

Target Level:

Nominal Logistic

m ¥

| Weight ||opriona!numeric

| Help |

| Run

Freq ||‘ count

|Va|idati0n | | optional

Remove

By | | optional

- Construct Model Effects

Add
Cross
Nest

Macros «

Degree
Attributes ||
Transform |=|

[] No Intercept

|
‘ [ Keep dialog open
|
|

softness

previous use

softness*previous use

temperature

softness*temperature

previous use*temperature
softness*previous use*temperature




Binomial Logist

e Overall model fit is
significant

e Softness doesn’t seem
to contribute too much

e Likelihood ratio test

e ROC Table

e sensitivity, specificity,
etc.

* Tools -> Help

= Detergent - Fit Nominal Logistic - JMP Pro

4 »*|Nominal Logistic Fit for brand

4 Effect Summary
Source

......... [ e el s we s e aa

Converged in Gradient, 3 iterations
Freg: count

I Iterations
4 Whole Model Test

4 Receiver Operating Characteristic

softness*temperature 0.043
softness 0.021

Remove Add Edit I:‘ FDR (' denotes effects with containing effects above them)

LogWorth

comm

Model -LogLikelihood
Difference 16.41281 11 32.82562
Full 682.24780
Reduced 698.66061
RSquare (U) 0.0235
AlCc 1388.81
BIC 1447.48
Observations (or Sum Wgts) 1008

D Fit Details

[ Parameter Estimates

4 Effect Likelihood Ratio Tests
Source Nparm DF
softness 2 2
previous use 1 1
softness*previous use 2 2
temperature 1 1
softness*temperature 2 2
previous use*temperature 1 1
softness*previous use*temperature 2 2

DF ChiSquare Prob>ChiSq

0.0006*

L-R

ChiSquare Prob>ChiSq

0.09804239
22.1316677
3.78609668
3.63914017
0.19617686
2.26089203
0.73731691

0.9522

ANNA *

<.0001
0.1506
0.0564
0.9066
0.1327
0.6917

— a X

c Regression (Demo): Report

= Detergent - Fit Nominal Logistic - JMP Pro

4 ' Nominal Logistic Fit for brand

4 Receiver Operating Characteristic

n

0.50

Sensitivi
True Posit

0.40

0.30

0.00 0.10 0.20 0.30 0.40 0.50 0.60 0.70 0.80 0.90

1-Specificity
False Positive

Using brand="m’ to be the positive level

AUC
0.59980
4 ROC Table

Sens-
Prob 1-Specificity Sensitivity (1-Spec)
. 0.0000 0.0000  0.0000
0.6714 0.0453 0.0940  0.0487
0.6418 0.0925 0.1800  0.0875
0.6042 0.1299 0.2380  0.1081
0.5843 0.2028 03420  0.1392
0.5392 0.2953 04520  0.1567
0.4821 0.3524 0.5060  0.1536
0.4623 0.4646 0.6040  0.1394
0.4569 0.5886 07100  0.1214
0.4310 0.7185 0.8100  0.0915
0.4167 0.8012 0.8700  0.0688
0.4107 0.8661 0.9160  0.0499
0.3818 1.0000 1.0000  0.0000
0.3818 1.0000 1.0000  0.0000

True Pos True Neg False Pos False Neg

0 508 0 500
47 485 23 453
90 461 47 410

119 442 66 381
171 405 103 329
226 358 150 274
253 329 179 247
302 272 236 198
355 209 299 145
405 143 365 95
435 101 407 65
458 68 440 42
500 0 508 0
500 0 508 0
2@ O~

TE L1 ]



https://stats.oarc.ucla.edu/other/mult-pkg/faq/general/faqhow-are-the-likelihood-ratio-wald-and-lagrange-multiplier-score-tests-different-andor-similar/
https://en.wikipedia.org/wiki/Sensitivity_and_specificity
https://en.wikipedia.org/wiki/Sensitivity_and_specificity

Your Turn (Hands-on)

* Do the same analysis without the softness variable
e Save the analysis script in the data table

* Challenge

* How to construct a table of correct classification rate at each probability
cutoff?

* What cutoff gives the best correct classification rate?

true positive + true negative

correct classification rate = —
f total # of predictions



K-Means Cluster Analysis

* A method to partition n observations into k clusters

 such that total within-cluster sum of squares (between observations to cluster
centroid) is minimized

* A cluster refers to a collection of data points aggregated together
because of certain similarities

* Need to set k
* There are methods to help you decide the value of k



K-Means Cluster Analysis: An Example

e Observations: 150 2-d points 4
3 ".;.:g;'
. Setk =3 e
 partition each observation to one of
the 3 clusters S = {5;, 55, S5} 00 & g
> o
< 0%
: : : Yoty ¢ O%o
* K-means clustering algorithm finds +IE¢*+*+ y 0% %
+
3 clusters such that P
3 aR A
. 2 ¥ %Qoo <o)
argmin E E lx — ;] | * %%oo%)oo
S o
j — . ex _©
l—l .')‘CESL | . OOOOOO
1 o

Within-cluster sum of squares

* .
RRXS



K-mean Cluster Platform

Demo

cluster - JMP Pro

Analyzel Graph Tools View Windo

k=

¥

Distribution
Fit Y by X

Tabulate
Text Explorer

Fit Model

Predictive Modeling
Spedialized Modeling
Screening

Multivariate Methods

#i- K Means Cluster - JIMP Pro — O

Clusters rows based on numeric variables into a specified number of clusters.

-Select Columns

*|2 Columns

|—
y

1 ~Cast Selected Columns into Roles

-Y, Columns|| 4 x

1~ Action

X

i 1

4y
Weight || optional numeric

Columns Scaled Individually |

Freq | optional numeric [

Clustering

Quality and Process
Reliability and Survival

Consumer Research

T vy e e e e o

-1.99912714 2.71285741

-1.47804153

3.2093591

1.8706766 0.77797407

File Edit Tables Rows Cols DOE
FReEFd| a8
| cluster D| 4 (w
P Source = E
1 2.6
20
3
4 0
>|Columns (2/0) | 5| 2.6
A x 6 1.5
Ay ARY
8 2.2
9 -2.1
10 1.7
11 3
12 -0.2
13 -1.8
*/Rows 14 0.7
All rows 150 15 0.
Selected 0 16
E)fcluded 0 17
Hidden 0
Labelled 0 18
19

-1.5933443 2.76898682

=2+ | Hierarchical Cluster
[ K Means Cluster

[# | Normal Mixtures
E Latent Class Analysis
[l | Cluster Variables

# cluster - K Means Cluste.. — O

4 = /Iterative Clustering

Columns Scaled Individually

4 Control Panel

Method

K Means Cluster v

Number of Clusters Range of Clusters (Op

B [ ]

[] Single Step
[] Use within-cluster std deviations

#% cluster - K Means Cluster ... — O X

4 =|Iterative Clustering

4 Cluster Comparison
Method NCluster CCC Best
K Means Cluster 3 20.5376 Optimal CCC

Columns Scaled Individually
[> Control Panel

Pkl =

Biplot

Biplot Options »
Biplot 3D

Parallel Coord Plots

Scatterplot Matrix

Save Colors to Table

[ ] shift distances using sampling rates

’ Save Clusters Creates
Save Cluster Formula table cc
number
Publish Cluster Formulas
Simulate Clusters
Save Cluster Distance N

28 v




Your Turn (Hands-on)

* Import the country_risk.xlsx data (data/basics/country_risk.xIsx)
* note that it’s an Excel file and column header starts at row 2

e Perform a pair-wise correlation analysis across the following 5 variables
e Corruption, Peace, Legal, GDP Growth, Population
* Note that Corruption and Legal variables are highly correlated

* hint: use the Multivariate platform
* Menu: Analyze -> Multivariate Methods - > Multivariate

* Perform a K-means cluster analysis
e As a start, use Peace, Legal and GDP Growth as factors; and set k=3
* Produce a scatterplot matrix

e Can you label each cluster (high-risk, medium-risk, etc.)?
* Hint: check Cluster Means



Model Selection

* Modeling for causal inference
* Valid each model to check model assumptions are satisfied
* e.g., analysis of residual in linear regression

* Pick a common metric to compare across models and pick the best one
e e.g., goodness of fit

* Modeling for prediction

* Training, validation, and test data split
* Training data: train/fit a model
e Validation data: tune a model, and select the final best model based on a certain metric
* Test data: obtain an unbiased performance measure of the final chosen model



Validation Column and Model Comparison

companies_mma - JMP Pro

O X

Validation Pred Formula Profits ($M) Pred Formula Profits ($M) 2
172.50108908 ~

382.18414941

4 Model Comparison - JMP Pro

Compares performance across models using prediction formula columns.

- Select Columns

> 10 Columns

th size

h Type

A sales ($M)
A profits (§M)
A # Employ
A Assets

A sales/emp

Validation

A Pred Formula Profits ($M)
A pred Formula Profits ($M) 2

- Cast Selected Columns into Roles

O
X

- Action

Cancel

Y, Predictors|| 4 Pred Formula Profits (§M)
A pred Formula Profits ($M) 2
optional

Group k. Validation
optional

Remove
Recall

Help

Weight optional numeric

Freq optional numeric

. N

n. nti i

File Edit Tables Rows Cols DOE | Analyze | Graph Tools View Window Help
| ao-d | B2 @ . &3 [ B Distribution
~ companies_mma [>| q w) Ex  FitybyX
P Source = oy - .
- B 17 Tabulate Training 11.889426293
240 Text Explorer Training 527.65004251
38 lidati 157.5415523
3% Fit Model adation
450 alidation 672.730148
— 512 Predictive Modelin » Neural
 Columns (10/0) | ok 9 | Neur
Specialized Modelin 4
th Type 79 g = Partition
A Sales (3M) Screening 4
Profits ($M 85 &é | Bootstrap Forest
:#rgnll Slg) ) 918 Multivariate Methods »
ploy . < | Boosted Tree
A Assets 10 4 Clustering »
A salesfemp gp 11137 .
W size P s Quality and Process » 80 | K Nearest Neighbors
ik, Validation 3 13 95 Reliability and Survival 4 ’H) A e
A Pred For...ofits (§M) & s Vi Machi
. 14 8 upport Vector Machines
4 Pred For..fits ($M) 25 Consumer Research »
EFS bl ol M 4 | Model Comparison
16 3418 784 0.283557636 small
17 34400 6756.7 0.1947209302 medium [J Make Validation Column
R 18 56000 4500 0.1063571429 big .
ows 2
1942100 83248 0.1402304038 big »@ | Formula Depot
All rows 32
Celected 0 2031404 5611.1 0.0942332187 medium Training 247.89836171
Excluded 0 21| 8527 1791.7 0.1405300809 small Training 50.383042221
At U 22 8578 6243 0.1154698065 small  Validation 27.076010199
Labelled 0 ) . e ——E——— - _ o

<

evaluations done

4 companies_mma - Model Comparison of Pred Formula Profits ($M), Pred Formul...

4 »/Model Comparison
[ Predictors

4 Measures of Fit for Profits ($M)
Validation
Training
Training
Validation
Validation

Predictor

Pred Formula Profits ($M)
Pred Formula Profits ($M) 2
Pred Formula Profits ($M)
Pred Formula Profits (§M) 2

Creator
Fit Least Squares ||| !
Fit Least Squares | || g
Fit Least Squares :

Fit Least Squares

.2.4.6.8 RSquare

0.5482
0.1261
0.0437
0.7592

RASE
319.22
443.97
12131
608.71

| H e

AAE Freq
213.24 24
294.59 24
602.01 8
451.34 8

https://www.jmp.com/support/help/en/17.1/#page/imp/example-of-model-comparison.shtml#



https://www.jmp.com/support/help/en/17.1/#page/jmp/example-of-model-comparison.shtml#

Outliers, Missing Values, a

@ companies_mma - JMP Pro

File Edit Tables Rows Cols DOE Analyzel Graph Tools View Window Help
‘l’_a a L..} Hl 3 @ = @ |I == Distribution
¥ .
|v companies_mma D" q g [*x FitYbyX
> S_OUTCG = e = | Lbulat ) # Employ Assets sales/emp size
: E‘t: bF)’lt---# Employ 4 py G faouate > 50816 5681.5 0.1327731423 big
ata Filter ===
5 |Cq Text Explorer 1 12068 27439 0.437852171 small
6 Ph v 54100 8497 0.1741589649 bi
3 Fit Model g
7 Ca 3 9500 2090.4 0.3027473684 small
8 Cc Predictive Modeling » 1 5000  468.1 0.14186 small
9|Cd Specialized Modeling y B 18000 1860.7 0.1640055556 small
10 | Ca : - nall
C Screening »| L | Explore Outliers I
|'C0|umns (7/0) ‘ 11 Cq .. a
e 12 | pH Multivariate Methods * B | Explore Missing Values edium
A Sales ($M) 13 Cc Clustering »| ] | Explore Patterns q
A Profits ($M) 14 | Ca ] nall
:# Employ 15 | pH Quality and Process » 27 | Response Screening ;
Assets bl sal | e
d sales/emp dp 16 | Ph Reliability and Survival g #%7 | Process Screening nall
th size § 17| Ph Consumer Research » = Predictor Screening edium
18 | Cérrmpore oo = g
19 | Pharmaceutical 5903.7 681 ﬁ Association Analysis g
20 Computer 29593 252 edium
21 | Pharmaceutical 11983 86 u-g frzzas sl 2 nall
22 |Computer 990.5 20.9 8578  624.3 0.1154698065 small
23 | Pharmaceutical 3243 4713 21300 3613.5 0.1522535211 medium
24 Computer 13823 0.3 2900 1076.8 0.4766551724 small
25 | Computer 1014 47.7 9100 977 0.1114285714 small
26 | Computer 1769.2 60.8 10200 1269.1 0.1734509804 small

nd Patterns

4 (= |Explore Outliers

4 Commands

L# companies_mma - Explore Outliers of # Employ - JMP Pro — O X

| Quantile Range Qutliers

| Values farther than some quantile ranges from the tail quantile

| Robust Fit Outliers

Given robust center and scale estimates, values far from center with

respect to scale

| Multivariate Robust Outliers

Given a robust centers and covariance, measure Mahalanobis

distance

|Multivariate k-Nearest Neighbor Outliersl Qutliers far from the kth nearest neighbors

4 Quantile Range Outliers

Tail Quantile
Q [ o]

[T] Restrict search to integers

Rescan
Close

Outliers are values Q times the interquantile range past the lower and upper quantiles.

[] Show only columns with outliers

Select columns and choose an action.
| Select Rows | |COIor Cellsl

|Exc|ude Rowsl |C0|0r Rowsl

|Add to Missing Value Codesl

Change to Missing

10% 90% Low High Number of Outliers
Column Quantile Quantile Threshold Threshold Outliers (Count)
# Employ 47956 82860 -229398 317053 1 383220

a8 O~

https://www.jmp.com/support/help/en/17.1/#page/imp/launch-the-explore-outliers-platform.shtml



https://www.jmp.com/support/help/en/17.1/#page/jmp/launch-the-explore-outliers-platform.shtml

Plan

e Session 1
 Workflow overview
e Basic data manipulation

e Session 2
e Join data tables
* JMP graphing

e Session 3

* Modelling
* JMP Journal
* JMP Scripting Language



JMP Journal — Communicate Your Results

* Create a JMP journal when you want to present your results

* A JMP journal combine two kind of presentations

 Static: embed output of JIMP (graphs and reports), fixed at a moment in time

* Dynamic: built from outlines containing text and buttons (links) that organize
data tables and reports

* Getting-started resources

* Dmitry’s video about JMP Journal on Quercus (6 mins)
e Creating, Using and Sharing JMP Journals (1 hour 11 mins)



https://www.jmp.com/en_in/events/ondemand/mastering-jmp/creating-using-sharing-journals1.html

JMP Script Language (JSL)

multiplication concatenate

variables —— i—radiua = 2:

comment oOperator operator quoted text string
+ Radius - IMP Pro \ / lulgﬂ
Fale Edit Thbles [OE Ana Graph T Add-Ins  View Windew Hgp
BB || & Be  |inptables) »|
1 -
2 Jff Compute the ar of ajcircle.
o = circle area = Pi() radias * radius;
o> Frinc{ "IThe are ig ™ || Formac{ circle aren, "Fixed™, 2 3 )i
functions Commas separate Semicolons separate
arguments. certain expressions.

https://www.jmp.com/support/help/en/17.1/#page/imp/jsl-building-blocks.shtml#



https://www.jmp.com/support/help/en/17.1/#page/jmp/jsl-building-blocks.shtml#

	Slide 1: Intro to JMP – Part 3
	Slide 2: Plan
	Slide 3: Modeling in JMP
	Slide 4: Binomial Logistic Regression
	Slide 5: Binomial Logistic Regression (Demo): Data
	Slide 6: Binomial Logistic Regression (Demo): Fit
	Slide 7: Binomial Logistic Regression (Demo): Report
	Slide 8: Your Turn (Hands-on)
	Slide 9: K-Means Cluster Analysis
	Slide 10: K-Means Cluster Analysis: An Example
	Slide 11: K-mean Cluster Platform (Demo)
	Slide 12: Your Turn (Hands-on)
	Slide 13: Model Selection
	Slide 14: Validation Column and Model Comparison
	Slide 15: Outliers, Missing Values, and Patterns
	Slide 16: Plan
	Slide 17: JMP Journal – Communicate Your Results
	Slide 18: JMP Script Language (JSL)

